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Introduction

FullRecall is a software that is able to help you to learn new things faster 
and KEEP them in your memory as long as you want to with a minimum waste 
of time. It is known that we keep forgetting things. The longer the time you used 
some information for the last time – the higher the probability that you will have 
trouble recalling it now.

If you want to keep some information in your mind – you have to repeat it 
from time to time. It is true that you could read certain books or articles or notes, 
every two weeks or  months.  But that  certainly would not be optimal,  as the 
amount of information keeps growing, and your time – isn't.

It would be best to extract only most important things in brief form of 
entries or questions with answers and repeat them only as often as absolutely 
necessary to keep them alive in your memory.

And thats exactly what FullRecall does: it schedules repetitions of your 
extracted information on exactly right time. Not too early, so you don't waste 
your time on repeating things you can still remember, and not too late, so you 
can still  recall the information and by that – refresh it in your memory. Use 
FullRecall daily – your time will not be wasted, since you will be presented with 
only those information, that you're close to forget.

FullRecall uses Artificial Neural Network (ANN) to learn your memory 
profile.  With  every  repetition  you  evaluate  how  well  you  remembered  an 
information using clear scale of grades. With this information ANN is able to 
extend or shorten the time to the next repetition of a certain item.

/Back to List of Contents/
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Examples of use of FullRecall

Where's  FullRecall  best  to  use?  The  most  important  example  is 
learning languages. To speak fluently some foreign language you have to 
remember certain amount of words. “Fluently” means also having a lot of 
words in memory and recalling them right away while speaking the language. 
FullRecall  allows you to  keep a  lot  of  words fresh  in  your  memory with 
minimum time used for repetitions.

Another  example  could  be  remembering  phone  numbers,  addresses, 
names and anything you want to keep in your memory instead of constant 
searching your notes, calendars and contact lists.

For students FullRecall can be a best tool to learn new subjects. With 
minimum effort of extracting information after every lecture (this can take as 
little as few minutes thanks to tools provided by FullRecall) – you can be 
perfectly prepared for an exam with minimum time used for learning. Let's 
take biology as an example: you can store extracted information on birds, 
proteins or cell structure using words, pictures or sounds. Using FullRecall 
daily  –  you  will  be  refreshing  informations  you  can't  remember  well. 
FullRecall will not bother you with things you can recall perfectly.

So after  a  while  you  will  find  yourself  well  prepared  for  an  exam, 
without last few days before an exam filled with rush and frantic devouring of 
names and diagrams and inability to remember everything at once.

/Back to List of Contents/
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Important note about the beginning of learning

When you're  beginning to  use  FullRecall  and you're  repeating daily 
your prepared information – you may start to think, that you're not learning 
much, because you are being asked things you just can't remember and things 
you have trouble recalling. Please, do not be discouraged! This is because you 
are being kept away from things you DO remember – and that's the whole 
idea: not to repeat things you remember but work on things you do not. So the 
initial difficulties are normal and expected. Soon you will remember those 
questions better and better and you will notice certain improvement.

Like  on  a  picture  above,  showing  learning  by  repetitions  and 
remembering a certain fact,  you will  find yourself remembering more and 
better. The key to this is working every day with FullRecall. Unfortunately, 
nothing will be done, unless you do it. FullRecall will help you to remember, 
and will make sure you do not spend more time learning then it's absolutely 
needed,  but  it  will  not  do  the  work  instead  of  you.  Nor  will  any  other 
software:)

/Back to list of contents/
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Database structure

Database:
You can store all your items directly in a FullRecall database, without any 

difference what a certain item is. But it's more neat to store your items divided 
into categories or even subcategories, so if need be, you can always choose what 
would you like to learn now: perhaps geography only, right before an exam, or 
some Spanish verbs because you keep forgetting them.

FullRecall  database is  divided into categories,  like on a picture below. 
When you add new items you would like to  learn,  you can add them to an 
existing category/subcategory or you can create new ones, just as you add an 
item.

The Queue:
There is  also something called the queue.  It  allows you to create new 

items, but without adding them to your review schedule. It's useful when you've 
got a lot to learn, and you're just not ready to review more new things, but you'd 
like to prepare some for a later time.

The queue is divided into the very same categories that the database. If 
you want to add a new category – it will appear in a database as well, and new 
items will be available for learning when you decide to add them. Adding items 
from the queue to the review schedule is done with New button in the menu to 
the right.

/Back to list of contents/
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Main Menu

Main menu consists of five elements:
→ File
→ Edit
→ Statistics
→ Options
→ Help

/Back to list of contents/

→ File

Menu File consists of five elements:

• Open/Create Another Database (alt+l, alt+o) allows you to open a file 
containing another database or create a new one.
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To open another database choose a right file in a dialog window and 
then click  Open button. To create new database select a right directory and 
click Create New button. If you type a nonexistent name in a Directory line 
and press Enter and Yes, new directory will be created with a given name.

• Knowledge Manager (ctrl+g) allows you to make certain changes in 
your database.

Edit allows you to edit selected element,  and then save it  with  Save 
button appearing in right menu. With  Delete button you can delete selected 
element or more elements, if you select them with control key.  Invert Q/A 
allows you to automatically swap question and answer in a selected item or 
items, if you select them with a control key. Close closes this window.

• On-line Manager allows you to  manage your on-line database.  This 
function is available for registered users only.

• Import/Export (alt+l, alt+i) consist of submenu:

◦ Network Import allows you to import (previously exported) database 
from a FullRecall server (for registered users only). This function is 
very  handy  if  you  want  to  keep  one  version  of  your  database 
accessible from everywhere. The database is stored on a FullRecall 
server. This function is available for registered users only.

◦ Import Questions&Answers From A File To The Queue allows you 
to import items stored in a file to the queue, without adding them to 
your review schedule. It's possible to import from a file with one of 
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following formats:
▪ FullRecall format
▪ SuperMemo format
▪ TXT format with questions and answers delimited with TAB.

◦ Import Data From Another FR Database (Merge Databases) allows 
you to make one database of two separate databases. All items from 
both will appear in currently opened database.

◦ Network Export allows you to export your database to the FullRecall 
server and keep it there – available from everywhere and always up 
to date. This option is available for registered users only.

◦ Export Questions&Answers To A File allows you to store parts or 
whole of your database in a file. You can choose from three formats: 
FullRecall format, SuperMemo format or text delimited with tabs.

• Exit (alt+F4) closes FullRecall window.

→ Edit

In this menu you have the following functions available:

They all allows you to edit certain properties of items in your learning 
process:

• Find An Item (ctrl+f) finds a certain item in your database. When you 
select this feature new menu appears:
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◦ Categories allows you to select categories to be searched. You don't 
have to look for an english verb in your biology section.

◦ Regex allows you to  use regular  expressions in  your  search.  Dot 
followed by star (.*) can be used to substitute any number of any 
characters.

Examples:
do.* typed in  a search window will  make FullRecall  find any items that 
contain words starting with “do”, like do, dot, down, dove.
.*ght.* will similarly display all items that contain words that start and end 
with any characters, but contain “ght” somewhere, like thought, wrought.

◦ Similar allows you to do less strict search, using fuzzy logic. This 
feature is available for registered users only.

◦ Exact allows you to look for an exact string of characters. Whatever 
you type in – FullRecall will look exactly for what you typed.

◦ Ignore Case allows you to  look for  words without  distinguishing 
between upper and lower case.

◦ Questions-only allows  you  to  perform search  amongst  questions, 
excluding answers.

• Edit Mode (ctrl+e) will allow you to edit currently visible item: retype 
and reformat text or add pictures or sounds. When you select edit mode 
new icons will appear in main menu bar:

• Delete This Item (ctrl+d) removes current item from your database.
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• Move To The Queue (ctrl+q) removes current item from your learning 
process and places it in the queue. It also resets interval for a current 
item: it is important to do so if an item is completely rewritten and has 
a different difficulty after the changes.

• Change Item Category (ctrl+o) changes the category that current item 
belongs to.  You can then relocate misplaced items that  you stumble 
upon during your learning process.

• Switch Question-Answer (ctrl+r) swaps question and answer of current 
item: what was the answer now is a question, what was the question 
becomes an answer.

• Current Category is a submenu. It allows you to change properties of 
current category:

◦ Background Color (ctrl+k) allows you to set a certain background 
color for a current category. This can be one more tool helping you 
to recall answers, separating categories more precisely. For example: 
you can set green for biology, blue for geography, yellow for physics 
etc., this way a color will associate with a certain knowledge field.

◦ Font  Color will  change  font  color  for  a  current  category.  Works 
similar to Background Color.

◦ Questions Font will allow you to set a font for all questions in a 
current category (typeface, size, etc.). For example you can set all 
questions to Italic.

◦ Answers Font works the same as Questions Font, only for answers. 
For example you can set all answers to Bold.

◦ Questions/Answers  Images works  similarly  to  the  Background 
Color, only allows you to use images instead of colors. For example 
you can use a picture of a distant galaxy as a background for your 
Astronomy category.

• Cancel Last Grade (ctrl+alt+z) allows you to cancel the grade you just 
gave yourself while learning. Easy to fix some wrong click.

/Back to Main Menu/
/Back to list of contents/

Page 10 of 28



→ Statistics

In this menu you can review your learning process:
• General  Statistics (ctrl+s)  will  show you three things (accessible by 

buttons to the right):
◦ General will  show  you  some  numbers  describing  your  learning 

process: for how long you're using FullRecall, how many items and 
categories you have in your database, how long intervals between 
reviews are, what average grades you gave yourself, and so on.

◦ Items/Reviews shows you how many items has a specific number of 
scheduled and executed reviews. It only counts reviews prepared by 
Ann,  doesn't  count  forced  reviews.  In  time  you  can  see  how 
numbers increase, as you work with FullRecall day by day.

◦ Items/Intervals shows you how many items has a specific interval, 
calculated  by  ANN.  In  time  you  can  observe  how  intervals  get 
longer, as you remember things better.

• Item's Statistics (ctrl+m) will show you all the data about current item. 
You can keep track of an item and it's learning process.

/Back to Main Menu/
/Back to list of contents/

→ Options

 In this menu you can switch and toggle properties of your FullRecall. 
What you see in Options is:

• Always On Top speaks for itself. Check to box to keep FullRecall on 
top of other windows.

• Fonts  allows  you  to  set  default  fonts  for  questions,  answers  and 
FullRecall interface:

• Settings is a main dialog box to change settings of your program. It has 
few tabs, each concerning different things:
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→ Main
→ Status Bar
→ Title
→ Keyboard
→ Grades
→ Difficult Items
→ Duplicates
→ Colors
→ Saving DB

/Back to list of contents/
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→ Main

In Main menu you can set most important variables to make FullRecall 
as handy as possible. Most options are explained at the bottom of the MAIN 
window and in yellow tips boxes – both appearing when you point a certain 
setting with a  cursor. Red arrow indicates where does the help appear (apart 
from tips boxes appearing right next to cursor).

• Exec tags ticked allow you to use external programs to open any files 
you'd  like  to  use  during  learning:  pictures,  movies,  sounds  etc.  if 
FullRecall isn't able to open certain file by itself (you can use pictures 
directly in FullRecall) .

Example:
<exec>mplayer ~/my_database/movie.avi</exec> will open mplayer and 
play movie.avi.

Information on exec tags you can also find in Help→Tips.
• Use categories ticked turns using categories on. E.g.: FR will ask  you 

about category when you'll be adding new items to your database.
• Inspirational  quotes  on start is  really self  explanatory.  Though they 

appear only when your interface language is English.
• Q/A  autoscale ticked  makes  questions  and  answers  boxes  scaled 
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according to space occupied by question andanswer.
• Allow to use uploaded user cases allows FullRecall to use data on your 

memory  from your  database  –  if  you've  uploaded  it  to  FullRecall's 
server. It's only to improve future ANN versions.

• Visual confirmation of keyboard shortcuts will make buttons look like 
really pushed when you use keyboard shortcuts. Just in case you'd like 
to see that the shortcut you used was the right one.

• Random pick from queue ticked makes FullRecall choose random item 
(instead of the first one) when introducing it to your learning process.

• Mix reviews from different categories makes FullRecall mix items from 
different categories when you're learning, so you don't get bored with 
geography when you've got also biology and history waiting for you.

• Auto-focus on grade buttons will make „Good” button selected when 
you need to grade your answer. You can use up and down arrows to 
move from grade to grade and „enter” to use a certain grade.

• Check for a new version makes FullRecall check for a new version at 
start up and once in a while when it's started, at most once in every 3 
hours. Since upgrades are quite often – it's useful to make FullRecall 
check for them.

• Splash screen on start ticked makes FullRecall to display it's logo on 
start.

• Beep on errors will make FullRecall beep when an error occurs, e.g 
when you're trying to open some menu before closing previous one.

• Text  margin  in  question/answer  fields inserts  a  certain  margin  (in 
pixels) around questions and answers. Just type in a number that makes 
the text look best for you.

• Prepend  question  with  category  name will  display  an  appropriate 
category before each question. If that will help you to recall answers – 
choose „Enabled” in this box.

• Auto-backups path:  if  you specify a path in this box FullRecall  will 
start to make backups of your database using this path. If you leave the 
box empty – backups won't be made.

• Net-export  data  on  exit:  if  you're  a  registered  user  you  can  make 
FullRecall to send your database to the FR server automatically, just 
choose how often you'd like to export your database.

• Cloze string defines string that replaces question if it's contained in the 
question.

Example:
You  need to  remember  that  „Neelakurinji  (Strobilanthes  kunthiana) 
blossoms once in 12 years”. You can make FullRecall to ask you about the 
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number of years by replacing it in the question by the cloze string „{?}”. 
Then what you see in the question will be:
„Neelakurinji (Strobilanthes kunthiana) blossoms once in {?} years”
and the answer will be:
„12”.
To use the cloze string: input the fact you'd like to remember, select the part 
you'd like to be asked for, right click, choose „Make it answer” (ctrl+N). 
Done.
Of course you can choose your own string you'd like to use.

• Interface  language is  self-explanatory.  You  can  choose  between 
English and Polish. Auto will make FullRecall decide based on your 
operating system language.

• Soft-limit  reviews per day will  limit  how many reviews you will  be 
presented per day. If you're feeling good enough – leave 0 for no limit.

• New day marks the date change for FullRecall. It's best to use the time 
you're  not  using  FullRecall  (like  while  you're  asleep)  so  you  don't 
encounter new repetitions during learning but when you wake up on the 
next day.

• Button order is there just for your convenience. You can choose which 
button you'd like to see first to the left: accepting or canceling one.

• Sound  files  handling  application gives  FullRecall  a  path  to  the 
application  that  will  play  sounds  for  you.  This  could  be 
/usr/bin/mplayer for linux.

/Back to Options/
/Back to list of contents/

→ Status Bar

In the Status bar menu you can rearrange your status bar. You can place 
it in the bottom or on the top of FullRecall window and you can alter what 
numbers will be shown there. All in nice self-explanatory drop down menus.

/Back to Options/
/Back to list of contents/

→ Title

Here you can change the title displayed in the title bar of FullRecall's 
window. You can customize the title including such information as path to 
your current database, FullRecall version or various numbers concerning your 
learning process.  All options with descriptions are listed in this menu and 
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you're also supplied with a training ground in the form of title simulation: you 
can see ahead what will be displayed in your title bar.

/Back to Options/
/Back to list of contents/

→ Keyboard

In this menu you can set various keyboard shortcuts to operate your 
FullRecall. The default settings are presented below.

To change a shortcut simply place a cursor in the cell you want to change and 
press shortcut you want to use. It will replace the old one.

/Back to Options/
/Back to list of contents/

→ Grades

In  this  menu  you  can  refine  your  grade  scale.  First  of  all  you  can 
choose from three types of scales: words from „Null” to „Ideal”, numbers 
from 0 to 5 or letters from „F” to „A”.

You can also change the feedback you give to ANN: you can make next 
intervals longer or shorter, depending on weights you give to your grades.

You  can  also  change  vertical  padding  of  your  grades'  buttons  (like 
making low grades smaller and high grades' buttons bigger).
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/Back to Options/
/Back to list of contents/

→ Difficult Items

In this menu you can decide when a certain item should be recognized 
as a difficult one. That means that if you still cannot remember it well after 
certain amount of repetitions – FullRecall will warn you about this item and 
suggest rephrasing it.

Perhaps  such  item  is  too  long  to  remember  it  well  and  should  be 
rephrased. Sometimes adding a picture or a sound could help. Sometimes one 
item can be broke into few items, thus better to remember.

/Back to Options/
/Back to list of contents/

→ Duplicates

In this menu you can instruct FullRecall what to do with items that are 
duplicated in various parts of your database.

In the Queue: you can choose to leave all items as they are or search for 
the  duplicates  and  remove  them  when  FullRecall  starts.  There's  another 
option for removing: you can remove items belonging the same category or 
remove all duplicates no matter what category they are in.

In  the  database  itself:  you  can  leave  all  items  intact  or  search  for 
duplicates by one of four self-explanatory filters.

All options are in two drop-down menus.

/Back to Options/
/Back to list of contents/

→ Colors

In this menu you can set your own colors for grades' buttons, e.g. red 
for null or green for ideal. Of course, if in your culture the meaning of colors 
is quite the opposite – you can have it all your way. Just double-click on the 
colour you wish to change, and from the scale shown below pick the colour 
you'd like to use.

Page 17 of 28



/Back to Options/
/Back to list of contents/

→ Saving DB

In this menu you can set frequency of saving your database and reviews 
done. This may be important when working on batteries and your hard drive 
has to spin each time you save or when saving large DB causes your device to 
lag. Here you simply choose how many last entered items or reviews done 
you're prepared to loose in case of power loss or computer crash. Of course 
you may choose to loose none.

/Back to Options/
/Back to list of contents/

→ Help

In this menu you have few tools available:

• Help displays brief  help window. You can find there,  among others, 
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descriptions of grades.
• Auto-Grab-Clipboard Mode turned on allows you to add items directly 

from other files or internet sites.  You just need to copy (ctrl+c) two 
pieces of text, one by one. The first one will automatically go into the 
question area in FullRecall window, the second one will automatically 
go into the answer area. This works for both, linux and windows, plus 
in linux you can also just select two pieces of text with mouse. This 
feature works constantly – you can add many items by simply copying 
more then two pieces  of  text:  each odd selected text  will  go to  the 
question area, each even selected text will go to the answer area. Two 
selected pieces of text make one FR item added to the database.

• Tips display few useful tips for FullRecall and for learning in general.
• License displays FullRecall's license.
• Register FullRecall allows you to register your FullRecall version. It 

disappears if you're registered User.
• FullRecall Website opens FullRecall site in your default web browser.
• About shows brief technical information about FullRecall.

/Back to Main Menu/
/Back to list of contents/

This is it, the end of Main Menu. The next stop is description of Right Menu 
Buttons.

/Back to Main Menu/
/Back to list of contents/
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Right Menu Buttons

• Review button
◦ Left clicked Review button allows you to start your 

normally scheduled reviews from all categories.
◦ Right clicked Review button allows you to choose 

categories from which you wish to review scheduled 
items. You can select one category or any categories you 
want with Control key.

• Input button
◦ Both, right and left clicked Input button allows you to add 

new questions to a category from your database or create 
new category for your new items.

• New button
◦ Left clicked New button allows you to add items waiting 

in the queue to your learning process.
◦ Right clicked New button allows you to add items to your 

learning process from the queue, but you're able to choose 
from which category or categories (selected with Control 
key) new items will come.

• Force button
◦ Left clicked Force button allows you to start reviews even 

if they are not scheduled, here and now.
◦ Right clicked Force button allows you to start reviews here 

and now, but from certain category or categories (selected 
with Control key).

/Back to list of contents/
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Tips & Tricks

→ Work with FullRecall regularly
Using FullRecall  every  day is  best.  It's  better  to  spend every day 1 

minute learning with FullRecall, than spending 7 minutes every 7 days. Also 
note that  FullRecall  schedules reviews with 1 day resolution,  but learning 
regularly even without the software pays off!

→ Don't be negligent during repetitions
Even if you remember a fact well, spend at least a few seconds thinking 

about it (the best would be to use a association using imagination here — 
some mnemonics) before going to the next item.

→ Don't give up
After some time (like a month), you may have a feeling that you don't 

learn much and that it's extremely hard to learn anything with FullRecall — 
you have so many repetitions and serious problems with recollecting answers. 
Remember that FullRecall doesn't repeat you items you remember well, but 
only these hard to remember that you're close to forgetting! Keep in mind that 
in  your  learning  process  are,  most  likely,  many  elements  that  you  do 
remember well — they are just not shown to you in order to not waste your 
time.

→ Keep questions and answers as short and simple as possible
Every time you repeat a item (and you'll have many repetitions) you'll 

have to read a question and an answer. The shorter the question and answer 
are, the less time you waste on the item. (Note that you should spend some 
time on every item, but ideally, spend most of the time  thinking about the 
answer, that reinforces your remembering of this item).

→ Don't add every information to FullRecall
Not every information is worth keeping in your memory, even though 

you can retain it in your memory (with help of FullRecall) relatively cheaply. 
Some facts are better off on paper,  on your notebook, palmtop, or remain 
accessible though google, than in your memory and FullRecall database. This 
is because there is a price to pay for keeping something in memory (time 
spend  on  reviews,  even  though  they  are  scheduled  on  optimal  days,  and 
interference with other information) and for some facts (i.e., facts you won't 
use much in the future, if at all) it won't pay off. It's up to you to judge what is 
worth retaining in your memory. Your judgment and priorities may change in 
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the future—don't hesitate to delete from your database elements you think are 
no longer worth keeping in your memory.

On the  other  hand,  bear  in  mind that  keeping in  memory facts  you 
remembered a long time ago is now very cheap (in terms of time spent on 
necessary  reviews);  it's  the  first  days,  weeks  and  months  of  keeping  an 
information in memory that you pay the highest price for. The longer you 
keep something in memory, the less price you pay for keeping it even longer 
(i.e.,  intervals between scheduled reviews start to be separated by order of 
years).

→ Other tips
• Click with the middle mouse button on question (or answer) field to 

turn on edit-mode.
• Clicking two times with left mouse button on a word selects the word; 

three times: selects a line.
• There is a context menu under right mouse button with some useful 

functions.
• You can use an Unicode character picker (like this one) to copy&paste 

Unicode characters into FullRecall (if you get a "square" in place of 
pasted character: make sure a question/answer font that is set in 
FullRecall Options cover the characters pasted, if not: set proper font 
(see 1st technical FAQ)

• If you want to go though scheduled reviews only in some categories, 
click "Review" with the right mouse button.

/Back to list of contents/
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Frequently Asked Questions

→ Is it really effective? How effective?

It is effective! Although it's difficult to make a reliable research to compare it 
with "common learning", once you know how it works (and know basics 
about human memory), it will be obvious for you that this is not a black 
magic — but an optimization, that just works.

However,  don't  expect  FullRecall  to  be  a  panacea  for  learning  troubles. 
Firstly, it  helps only with  remembering knowledge, not understanding it. 
Secondly, when you have a frequent contact with the material you learn (i.e., 
you have many natural repetitions beside these in FullRecall) then FullRecall 
won't help you so much with this material.

Last, but not least: FullRecall optimizes your time spend on memorizing, 
allows you to focus your effort in the right way, in the optimal time. But it's 
your effort that is the crucial factor influencing the learning rate — if you 
won't  make  the  serious  effort  trying  to  really  remember  every item then 
FullRecall will slow down the learning rate for you trying to match your 
"lazy  forgetting  curve".  On  the  other  hand,  if  you'll  commit  yourself  to 
learning and won't skim though reviews: you'll remember much more then 
you would remember in the same time, making the same effort, but learning 
without the software.

Technical questions and problems

→ I don't see properly some characters.

Please choose a font (menu Options→Fonts→Questions/Answers fonts) that 
covers  the  encoding  you  use.  If  another  application  correctly  displays 
affected text: please try to find out what font the other application is using 
and set the same font in FullRecall. On MS Windows you'll find Lucida Sans 
Unicode: it supports most commonly used characters and looks good; other 
universal fonts (not available by default on MS Windows) are:  Code2000 
(shareware),  Cyberbit,  Arial  Unicode MS (supplied with MS Office 2002 
(XP) and MS Office 2003).  See also:  List of Unicode Fonts. In Windows 
you  can  drag&drop  *.ttf  fonts  files  into  "Control  Panel"→Fonts.  In 
Unix/Linux since XFree86-4.3 you can just copy the *.ttf fonts to ~/.fonts/, 
and  they  should  be  visible  in  FullRecall  (after  FullRecall  restart),  in 
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Options→Preferences→Fonts.

→ Is it safe to copy FullRecall database from/to Windows version 
to/from Linux version or other operating systems?

Yes! Format of all files is fully compatible between 
Windows/Linux/FreeBSD/Pocket-PC versions.

→ When does the ANN get trained exactly?

During repetitions, in the background, using about 200 ms of CPU time just 
after an answer or question is presented. The faster your CPU is, the faster 
ANN can grip your memory model. But don't worry even if you use a very 
slow CPU — it still should work okay, as it's well optimized.

→ What are these files: weights.bin, user_cases.bin?

weights.bin contains internal ANN weights, so they don't have to be 
recomputed again from ANN learning data every time FullRecall starts 
weights.bin file is saved from scratch everytime FullRecall is closed
user_cases.bin contains data collected from the user to train ANN

→ Is it possible to start FullRecall with a specific (other that recently 
used) database?

Yes, using -d parameter (and path after -d, with space between) from 
command line (example: fullrecall.exe -d c:\path-to-the-database\)

→ Exec tags don't work for me with a program placed in "Program 
Files".

The space between Program and Files is the problem. A way around it:

add "C:\Program Files\The-Program" to the system path (right click on My 
computer→Properties→Advanced→Environment Variables→System 
variables, edit "Path" variable - add to it: ;C:\Program Files\The-Program.

Now, provided 'exec tags' are turned on in FullRecall settings, this should 
work: <exec>the_program.exe c:\a_folder\image.jpg</exec>

→ I sometimes get a message "This item is difficult and probably should 
be rewritten (Ctrl-E)", what's wrong?

The warning says that the item have been repeated many times and interval 
is still low. In other words: the item is very difficult and you spend much 
time on it. Some items are just difficult and we can do nothing about it, so in 
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such  cases  it's  safe  to  ignore  the  warning.  But  in  most  cases:  we  can 
reformulate  question  and  answer  to  make  answer  easier  to  remember. 
Question should be specific; answer should be short, ideally just one word; 
question should never force to you to enumerate many items (such questions 
can be often split into more items, every item that demands short, specific 
answer); sometimes you can also add an image or sound, or even a more 
explicit hint for the difficult item. After any substantial changes to the item, 
please use "Move to queue" feature from "Edit" menu, so the item will be 
reintroduced  to  the  learning  process  from the  scratch  (as  it  may  have  a 
different difficulty after the changes).

→ user_data.bin file got a bit smaller, is this OK?

Yes.  An  internal  user_cases.bin file  optimizer  (which  is  called  when 
FullRecall  decides  that  the  file  needs  optimization)  optimizes  the  file 
structure  (so  FullRecall  can  start  faster):  merges  data  and  throws  away 
redundant data, which may result in a smaller file.

→ How to do global search&replace?

Close FullRecall, make a backup of database directory, open  elements.xml, 
do  a  global  search&replace  in  you  editor  of  choice,  save  changed 
elements.xml and start FullRecall.

→ What are the program limits (size of the database)?

8 kB per one question, 8 kB per one answer, 128 B per category name. No 
limits  whatsoever  as  to  number  of  items in  the  database  nor  size  of  the 
database  (though  free  version  is  limited  to  500  elements  per  database).
Network import/export  has additional limits (4 MB per file or 2 MB per 
compressed file).

→ Can I upgrade FullRecall? Will the new version read an old 
database?

Yes. Newer versions are designed to read fully databases of older versions. 
Please, make a backup of your database before upgrading though, just in 
case.

→ Is it possible to use FullRecall from USB based flash drive?

Yes. Copy the executable and folder with the database along with its 
contents to the USB drive (a sub-directory is fine).
If you don't know where the folder with the database is: it's path is always 
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visible in FullRecall title bar.
You can create on the flash drive a batch file (example: "start.bat") that will 
start FullRecall from specific (relative) directory (using -d parameter), 
example: fullrecall.exe -d fullrecalldb\
If you use images and/or sounds, try to keep them in a sub-directory of the 
database-directory if possible (also see the next FAQ entry).

→ Is it possible to make FullRecall store relative (not absolute) paths for 
images and sounds?

Yes,  images  and  sounds  stored  inside  the  database  directory  (or  its  sub-
directory) have paths automatically converted to relative. Example: if your 
database  directory  is  "C:\fullrecalldb\"  and  you  keep  images  in 
"C:\fullrecalldb\images\" and sounds in "C:\fullrecalldb\sounds\", the paths 
(to  images and sounds)  in  FullRecall  database will  be stored as  relative.
Relative paths takes less space in the database and are portable from one 
computer to another.

→ How to start FullRecall 1.2.x (or newer) on Windows 98/Me?

FullRecall-1.2.x (or newer) on Windows 98/ME needs unicows.dll file from 
MSLU (Microsoft Layer for Unicode); you can download MSLU here. After 
downloading unpack and place the unicows.dll file in "C:\Windows\System\" 
and  FullRecall  should  be  able  to  start  now.  (NOTE:  it  won't  help  with 
Windows  95  as  it  is  not  supported  at  all  by  FullRecall-1.2.x  and  newer 
versions).

→ Is it possible to use find-feature with a wildcard (*)?

Yes. In general  FullRecall  allows you to use  regular expressions;  regular 
expressions  offer  more  than  just  the  wildcard,  but  have  rather  beginner-
unfriendly syntax. For the simple problem of the wildcard, you can use ".*" 
instead  of  "*"  (example:  ctrl+f,  make  sure  "Use  regular  expressions"  is 
turned on,  in  place of  your  "*" use  ".*").  For more details  (and the  full 
syntax) about regular expressions, see external sources.

→ Is it possible to use own server (for network import/export)?

No, but  you achieve the  same with  a  "start  script"  that  would  be called 
instead of real FullRecall binary: the start script can download your current 
database from your own server,  the start  FullRecall,  and (after FullRecall 
quit)  upload  the  database  to  your  own  server  (by  ftp,  scp,  or  whatever 
protocol you like). Example:
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#!/bin/bash
#script called before FullRecall start:
/home/dca/scripts/download-my-current-frdatabase.sh

#start FullRecall
/usr/bin/fullrecall-linux.bin

#upload the database to my server:
/home/dca/scripts/upload-my-current-frdatabase.sh

A similar solution with a .bat file for MS Windows is possible. The files that 
the  "start  script"  needs  to  transfer  are  all  files  in  a  current  FullRecall 
database (path to the current database directory is always visible in a title bar 
of  running  FullRecall).  If  you  need/want  to  extract  the  current  database 
directory in  the upload/download scripts:  Linux/FreeBSD versions:  “grep 
pathtodatadir ~/.foxrc/FullRecall”, MS Windows version:

HKEY_CURRENT_USER/Software/FullRecall/SETTINGS/pathtodatadir

→ How does FullRecall decide if an item is "difficult and perhaps 
should be rewritten"?

By default, when item has been repeated at least 16 times (not counting any 
forced  reviews or  multiple  reviews done  on the  same day)  and interval-
scheduled-by-ann is still below 16 days. The threshold is configurable.

→ Does “forced review” skew ANN?

No, it doesn't skew ANN in any way. Forced reviews are usually suboptimal 
investing of ones time (unless one wants to increase retention disregarding 
optimal time/results ratio, like right before an exam), but they are not bad in 
any way from ANN point  of  view (at  the worst,  ANN just  doesn't  learn 
anything from such review).

→ How can I import data from Excel?

FullRecall can import data from MS Excel (and possibly from other, non-
Microsoft, spreadsheet applications) provided data is exported from Excel in 
tab-delimited format. So all you need to do is to pick (in Excel) "Save as..." 
from "File" menu and set "Save as type" option (at the bottom of "Save as" 
dialog) to "Text, Tab delimited".

Then, in FullRecall pick "Import Questions&Answers From A File To The 
Queue..."  available  under  File→Import/Export  menu  and  choose  the  file 
exported from Excel.
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→ How to keep images and sound files cross-platform?

Please keep your images and sounds inside of FullRecall's learning database 
directory. If your learning database directory is "C:\frdb\", then keeping 
images (and sounds) in "C:\frdb\", or any subdirectory (like 
"C:\frdb\images\") will result in images (and sounds) stored in FullRecall 
database as relative paths that will be portable (see also FAQ question “Is it 
possible to make FullRecall store relative (not absolute) paths for images 
and sounds?” above).
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